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Note pour les utilisateurs Mac

Certaines combinaisons de touches et certains éléments de menus sont différents entre un Mac et
Windows ou Linux. La table ci-dessous donne quelques équivalents pour les instructions de ce
chapitre. Pour une liste plus détaillée, voyez dans 'Aide.

Windows/Linux Equivalent Mac Effet

Sélection de menu LibreOffice > Préférences Acces aux options de paramétrage
Outils > Options

Clic droit 3 +clic Ouvre un menu contextuel
Ctrl (Contréle) 3 (Commande) Utilisé avec d'autres touches
F5 Maj+38+F5 Ouvre le Navigateur

F11 #+T Ouvre la fenétre Styles & Formatage
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Qu'est-ce que Calc ?

Calc est le composant tableur de LibreOffice. Vous pouvez entrer des données (habituellement
numériques) dans une feuille de calcul et ensuite manipuler ces données pour produire certains
résultats.

Vous pouvez ensuite entrer des données et utiliser Calc dans une démarche ‘Et si..." en changeant
certaines des données et en observant les résultats sans avoir a ressaisir tout le classeur ou toute
la feuille de calcul.

Les autres fonctionnalités fournies par Calc comprennent :

* les fonctions, qui peuvent étre utilisées pour créer des formules afin d'effectuer des calculs
complexes sur les données ;

* les fonctions de base de données, pour classer, stocker et filtrer les données ;
* les graphigues dynamiques ; une grande variété de graphiques 2D et 3D ;

* les macros, pour enregistrer et exécuter des taches répétitives ; les langages de script
supportés comprennent LibreOffice Basic, Python, BeanShell et JavaScript ;

* la capacité d'ouvrir, de modifier et d'enregistrer des classeurs Microsoft Excel ;

* ['import et I'export de classeurs dans de multiples formats, dont HTML, CSV, PDF et
PostScript.

Si vous voulez utiliser des macros écrites dans Microsoft Excel utilisant le code
Note macro VBA dans LibreOffice, vous devez d'abord en modifier le code dans I'éditeur
LibreOffice Basic IDE. Voir Chapitre 12 (Macros Calc).

Classeurs, feuilles de calcul et cellules

Calc fonctionne avec des éléments appelés classeurs. Les classeurs se composent d'un certain
nombre de feuilles individuelles, chaque feuille contenant des cellules disposées en lignes et en
colonnes. Une cellule particuliére est identifiée par son numéro de ligne et la lettre de sa colonne.

Les cellules contiennent des éléments individuels — textes, nombres, formules, etc. — qui forment
les données a afficher et a manipuler.

Chaque classeur peut avoir plusieurs feuilles, et chaque feuille peut avoir plusieurs cellules
individuelles. Chaque feuille peut avoir au maximum 1 048 576 lignes (65 536 lignes dans Calc 3.2
et moins) et au maximum 1024 colonnes.

Interface de Calc

Quand Calc est démarré, la fenétre principale ressemble a la Figure 1.

Si une partie de la fenétre de Calc (Figure 1) n'apparait pas, vous pouvez l'afficher
en utilisant le menu Affichage. Par exemple, Affichage > Barre d'état va basculer
(afficher ou masquer) la barre d'état. Il n'est pas toujours nécessaire de tout afficher,
comme sur la Figure 1 ; affichez ou masquez ce que vous voulez.

Note
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Figure 1 : Espace de travail principal de Calc

Barre de titre

La barre de titre, située en haut, affiche le nom du classeur courant. Lors de la création d'un
classeur, son nom est Sans nom X, ou X est un nombre. Quand vous enregistrez un classeur pour
la premiere fois, vous devez saisir le nom de votre choix.

Barre de menus

En dessous de la barre de titre se trouve la barre de menus. Quand vous choisissez I'un des
menus, un sous-menu apparait avec d'autres options. Vous pouvez modifier la barre de menus,
comme indiqué au Chapitre 14 (Paramétrer et personnaliser Calc).

* Fichier contient des commandes qui s'appliquent au document entier, comme Ouvrir,
Enregistrer, Exporter au format PDF et Sighatures numériques.

* Edition contient des commandes pour modifier le document, comme Annuler,
Modifications, Comparer le document et Rechercher & remplacer.

e Affichage contient des commandes pour modifier I'apparence de l'interface utilisateur de
Calc, comme Barres d'outils, Plein écran et Zoom.

* Insertion contient des commandes pour insérer des éléments, comme des cellules, des
lignes, des colonnes, des feuilles et des images dans un classeur.
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* Format contient des commandes pour modifier la présentation d'un classeur, comme
Styles et formatage, Cellules et Fusionner les cellules.

¢ Outils contient des fonctions, comme Orthographe, Partager le document, Contenu des
cellules, Gallery et Macros.

* Données contient des commandes pour manipuler les données dans votre classeur,
comme Définir la plage, Trier, Filtre et Table de pilote.

* Fenétre contient des commandes pour la fenétre d'affichage, comme Nouvelle fenétre,
Scinder et Fixer.

¢ Aide contient des liens vers le fichier d'Aide fourni avec le logiciel, Qu'est-ce que c'est ?
et Vérifier les mises a jour.

Barres d'outils

Calc comporte plusieurs types de barres d'outils : ancrée (a place fixe), flottante et détachable. Les
barres d'outils ancrées peuvent étre déplacées a différents endroits ou rendues flottantes, et les
barres d'outils flottantes peuvent étre ancrées.

Trois barres d'outils sont situées sous la barre de menus par défaut : la barre d'outils Standard, la
barre d'outils Formatage et la barre de formule.

Les icones (boutons) dans ces barres d'outils fournissent une large gamme de commandes et de
fonctions ordinaires. Vous pouvez également modifier ces barres d'outils, comme indiqué au
Chapitre 14 (Paramétrer et personnaliser Calc).

Placer le pointeur de la souris sur chacune de ces icones fait apparaitre une petite boite, appelée
info-bulle. Elle donne une bréve explication de la fonction de I'icbne. Pour une explication plus
détaillée, choisissez Aide > Qu'est-ce que c'est ? et placez le pointeur de la souris sur l'icone.
Pour désactiver cette fonction, cliquez dessus ou appuyez sur la touche Echap. Les astuces (info-
bulles) et les astuces détaillées (info-ballons) peuvent étre activées ou désactivées depuis Outils
> Options > LibreOffice > Général.

Afficher ou masquer les barres d'outils

Pour afficher ou masquer les barres d'outils, choisissez Affichage > Barres d'outils, puis cliquez
sur le nom de la barre d'outils dans la liste. Une barre d'outils active a une coche devant son nom.
Les barres d'outils détachables ne sont pas listées dans le menu Affichage.

Palettes et barres d'outils détachables

Les icones de barres d'outils avec un petit triangle a droite permettent d'afficher des palettes, des
barres d'outils détachables et d'autres fagons de sélectionner des choses, selon l'icne.

Un exemple de palette est montré Figure 2. Il est affiché en cliquant sur le petit triangle sur la
droite de l'icbne Bordures.

" Bordures A
g1 ] T
o] ] ] =
=5/ |

Figure 2 : Palette de barre d'outils
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Un exemple de barre d'outils détachable est montré Figure 3. Les barres d'outils détachables
peuvent étre flottantes ou ancrées sur le bord de I'écran ou dans l'une des barres d'outils
existantes. Pour déplacer une barre d'outils détachable flottante, glissez-la par la barre de titre.

HeCI/HE Organigramme T X 3. Cliquez ici et glissez
Hiee v E e ¢ & HE pour déplacer

@V EAY P . Hd=e aw

X AVEPD @9 EFSSD

QE @@ X AVEWD

= W @
E T g] i T E @ [=] L__U I
- - % - Y
1. Cliquez ici et glissez 2. La palette se détache et flotte

Figure 3 : Exemple d'une barre d'outils détachable

Déplacer les barres d'outils

Pour déplacer une barre d'outils, placez le pointeur de la souris sur la poignée de la barre d'outils,
pressez le bouton gauche de la souris, glissez la barre d'outils jusqu'a son nouvel emplacement et
relachez ensuite le bouton de la souris.

Poignées des barres d'outils ancrées

Sans nom 1 - LibreOffice Calc

Eichier Egitiu:un Affichage Insertion Format Outils Données  Fenétre  Aide

EB-EBH= EER PE KB B-

- @ | Arial xjj0 [z] 6 I § = ===
Al ] % & =]
s
2
]

Figure 4 : Déplacer une barre d'outils ancrée

Pour déplacer une barre d'outils flottante, cliquez sur sa barre de titre et glissez-la jusqu'a son
nouvel emplacement, comme indiqué Figure 3.

Ancrer/faire flotter les fenétres et les barres d'outils

Les barres d'outils et certaines fenétres, comme le Navigateur et la fenétre Styles et formatage,
sont ancrables. Vous pouvez les déplacer, changer leurs dimensions ou les ancrer & un coté.

Pour ancrer une barre d'outils a sa derniére position, affichez son menu contextuel en effectuant
un clic droit sur la barre, puis choisissez Ancrer la barre d'outils. Pour supprimer I'ancrage,
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déplacez la barre a l'aide de la poignée comme expliqué ci-dessus. Vous pouvez également ancrer
ou détacher une barre d'outils en maintenant appuyée la touche Ctrl et en double-cliquant dans la
barre ailleurs que sur un outil.

Pour ancrer ou supprimer I'ancrage d'une fenétre, cliquez n'importe ou dans la fenétre et utilisez la
combinaison de touches Ctrl+Maj+F10, ou maintenez appuyée la touche Ctrl et double-cliquez
dans le cadre de la fenétre ancrée prés des icbnes du haut.

Mavigateur L
Colon A - B B 8
Ligne 1 H |25 R ee -

t B Feuilles

Eg| Moms de plage

&5 Plages de base de données

E’ Plages lices
Figure 5 : Ctrl + double-clic pour ancrer ou
supprimer l'ancrage

Avec certaines configurations, le glisser-déposer est une autre possibilité. Pour ancrer une fenétre,
cliguez sur la barre de titre et faites-la glisser vers un c6té de la fenétre principale. Un cadre en
pointillé indiguera son futur emplacement.

Personnaliser les barres d'outils

Vous pouvez personnaliser les barres d'outils de plusieurs fagons, comme choisir quelles icones
sont visibles et verrouiller la position d'une barre d'outils ancrée.

Pour accéder aux options de personnalisation d'une barre d'outils, faites un clic droit a l'intérieur de
la barre.

Pour afficher ou masquer les icones définies pour la barre d'outils sélectionnée, choisissez
Boutons visibles dans le menu contextuel. Les icones visibles sont indiquées par une bordure
autour de l'icéne (Figure 6). Cliquez sur les icones pour les masquer ou les faire apparaitre dans la
barre d'outils.

Charger I'URL

MNouveau

E=N FoR|ExE

Mouveau docubagnt 3 partir d'un modele

Quvrir
Enregish

Enregistrer sous...

= }}E 3
| - § @ Sources de données
€) Aide de LibreOffice

I

Bersonnaliser la barre d'outils...

lcdnes visibles
Document par e-mail
Editer le fichier

Export direct au for

Impression rapide (EPZ0OMN Stylus DX5000 Series)

Apergu

B

Blogquer la position des barres d'outils

Fermer la barre d'outils

d H0e @ 0e@Wodse

T 5| Orthoaraohe
Figure 6 : Sélection des icbnes de barres d'outils visibles
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Vous pouvez utiliser une icbne masquée en cliquant sur la double fléeche ” 2 la droite de la barre
d'outils. LibreOffice n'affiche cette double fleche que lorsque la taille de la fenétre ne permet pas
d'afficher toutes les icones.

Vous pouvez également ajouter des icones et créer de nouvelles barres d'outils, comme indiqué
au Chapitre 14 (Paramétrer et personnaliser Calc).

Barre d'outils Formatage

Dans la barre d'outils Formatage, les trois listes déroulantes sur la gauche sont Appliquer le
style, Nom de police et Taille de police (voir Figure 7). lls indiquent les parametres actuels pour
la cellule ou la zone sélectionnée. (La liste Appliquer le style peut ne pas étre visible par défaut.)
Cliquez sur la fleche vers le bas a la droite de chaque boite pour ouvrir la liste.

Appliquer le style Nom de police | | Taille de police
| @d F'ardéfa} T Arizl ‘ T 10* m G
||:'|.J, - f‘: E =
| | B - C D | E

| 1
Figure 7 : Listes déroulantes Appliquer le style, Nom de police et Taille de police

Si certaines icones (boutons) de la Figure 7 ne sont pas visibles, vous pouvez les
faire afficher en faisant un clic droit dans la barre d'outils Formatage, en
sélectionnant Boutons visibles dans le menu déroulant, et en sélectionnant l'icbne
désirée (par exemple, Appliquer le style) dans le menu contextuel. Il n'est pas
toujours nécessaire d'afficher tous les boutons de la barre d'outils, comme indiqué ;
affichez ou masquez chacun d'entre eux, comme vous le souhaitez.

Note

Barre de formule

Du coté gauche de la Barre de formule se trouve une petite boite de texte, appelée Zone de nom,
avec a l'intérieur la combinaison d'une lettre et d'un numéro, comme A1 dans la Figure 8. Cette
combinaison, appelée référence de cellule, est la lettre de la colonne et le numéro de la ligne de la
cellule sélectionnée.

Assistant
fonctions Fonction
A >
Al * M E = -4— Ligne de saisie
| \ [ B \ : b [ E |
’_ w1
7 Zone de nom Somme

Figure 8 : Barre de formule

A droite de la Zone de nom se trouvent les boutons Assistant Fonctions, Somme et Fonction.

Cliquer sur le bouton Assistant Fonctions ouvre une boite de dialogue a partir de laquelle vous
pouvez effectuer une recherche dans une liste de fonctions disponibles. Ce peut étre trés utile
parce que cela montre également comment les fonctions sont formatées.

Interface de Calc 11



Dans un classeur, le mot fonction recouvre davantage que les fonctions mathématiques. Voir
Chapitre 7 (Formules et fonctions) pour plus de détails.

Cliquer sur le bouton Somme inséere dans la cellule courante une formule qui totalise les nombres
des cellules situées au-dessus de la cellule courante. S'il n'y a pas de nombres au-dessus de la
cellule courante, la formule Somme utilise les cellules contenant des nombres situées a gauche.

Cliquer sur le bouton Fonction insére un signe égal (=) dans la cellule sélectionnée et dans la
ligne de saisie, permettant ainsi a la cellule d'accepter une formule.

Quand vous entrez une nouvelle donnée dans une cellule, les boutons Somme et Fonction se
changent en boutons Annuler et Accepter ¢ p# .

Le contenu de la cellule courante (donnée, formule ou fonction) est affiché dans la Ligne de
saisie, qui est le reste de la barre de formule. Vous pouvez modifier le contenu de la cellule
courante soit ici, soit dans la cellule courante. Pour modifier dans la zone Ligne de saisie, cliquez
dans la zone, puis tapez vos modifications. Pour modifier dans la cellule courante, double-cliquez
simplement dans la cellule.

Menus par clic droit (contextuel)

Un clic droit dans une cellule, un graphique ou un autre objet ouvre un menu contextuel. Souvent
le menu contextuel est la maniére la plus rapide et la plus facile pour atteindre une fonction. Si
VOUS ne savez pas si une fonction se situe dans des menus ou des barres d'outils, vous pouvez la
trouver en effectuant un clic droit.

Cellules individuelles

La section principale de I'écran montre les cellules sous forme de grille, avec chaque cellule qui se
situe a l'intersection d'une colonne et d'une ligne.

Au-dessus des colonnes et a gauche des lignes se trouvent des séries de boites grises qui
contiennent des lettres et des numéros. Ce sont les en-tétes de colonnes et de lignes. Les
colonnes commencent a A et se poursuivent sur la droite, et les lignes commencent a 1 et se
poursuivent vers le bas.

Ces en-tétes de colonnes et de lignes forment les références de cellules qui apparaissent dans la
Zone de nom de la Barre de formule (voir Figure 8). Vous pouvez faire disparaitre ces en-tétes en
sélectionnant Affichage > En-tétes de colonnesllignes.

Onglets

En dessous de la grille des cellules se trouvent les onglets. Ces onglets permettent I'accés a
chaque feuille individuelle, la (les) feuille(s) visible(s) (actives) ayant un onglet blanc. Cliquer sur
un autre onglet permet d'afficher cette feuille et son onglet devient blanc. Vous pouvez également
sélectionner de multiples feuilles en une fois en gardant la touche Ctrl appuyée pendant que vous
cliquez sur les noms.

Vous pouvez choisir la couleur des différents onglets. Faites un clic droit sur I'onglet et choisissez
Couleur d'onglet depuis le menu déroulant pour ouvrir la palette des couleurs. Pour ajouter de
nouvelles couleurs a la palette, voir “Options de couleurs” au Chapitre 14 (Paramétrer et
personnaliser Calc).
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Insérer une feuille...
[;3 // (I Supprirner la feuille... ..
Feuillel /3 Rengmmer la feuille... SEERERREE

Déplacer/Copier la feuille... . . ...
.

Protéger la feuille..,
Par défaut

Evénernents de |a feuille...

Figure 9 : Choisir la couleur d'onglet [ Aide ] [ ok ” Annuler l

Barre d'état

La barre d'état de Calc fournit des informations sur le classeur et des moyens pratiques pour
changer rapidement certaines de ses fonctionnalités.

Feuillel /1 Par défaut [ | >
> g v A 0w

Numeéro de Style Mode Mode de Changements
feuille de page insertion sélection non enregistrés

Figure 10 : C6té gauche de la barre d'état de Calc

Somme=0 = { + | 100%
o ¥ > A

Signature  Information sur la Curseur Pourcentage
numerique cellule ou I'objet du zoom dezoom

Figure 11 : Cété droit de la barre d'état de Calc

Numéro de séquence de la feuille ( Feuillel /1 )

Indigue le numéro de séquence de la feuille courante et le nombre total de feuilles dans le
classeur. Le numéro de séquence peut ne pas correspondre au nom dans I'onglet. Un double
clic dans cette zone permet d'ouvrir le Navigateur.

Style de page (| Par défaut )
Indique le style de page de la feuille courante. Pour modifier le style de page, double-cliquez
sur ce champ. La boite de dialogue Style de page s'ouvre.

Mode insertion ( Ecraser )
Appuyez sur la touche Ins pour basculer entre les modes Insertion (Zone vide) et Ecrasement
(Ecraser) quand vous saisissez. Ce champ est & blanc quand le classeur n'est pas en mode
saisie (par exemple, quand vous sélectionnez des cellules).

Interface de Calc 13



Mode sélection ( " )
Cliquez pour choisir parmi les sélections standard, étendue, avec ajout ou par bloc. Voyez
page 27 pour plus d'informations.

Changements non enregistrés ( - )
Une icbne apparait ici si des changements dans le classeur n'ont pas été enregistrés. Double-
cliguez sur cette icbne pour enregistrer le classeur.

Signature numérique (|Lﬂ)
Si le document n'a pas été signé numériquement, un double-clic dans cette zone ouvre la boite
de dialogue Signatures numériques, ou vous pouvez signer le document. Voyez Chapitre 6
(Imprimer, exporter et envoyer par e-mail) pour plus d'informations sur les signatures
numériques.

Si le document a été signé numériquement, une icéne ||—ﬂ apparait dans cette zone. Vous
pouvez double-cliquer sur l'icbne pour voir le certificat. Un document peut étre signé
numériguement seulement apres avoir été enregistré.

Information sur la cellule ou I'objet ( >*Mmme=0 )
Affiche de l'information sur les éléments sélectionnés. Quand un groupe de cellules est
sélectionné, la somme de leur contenu est affichée par défaut ; vous pouvez faire un clic droit
dans ce champ et sélectionner d'autres fonctions, comme la valeur moyenne, la valeur
maximum, la valeur minimum ou le comptage (nombre d'éléments sélectionnés).

Quand le curseur se trouve sur un objet comme une image ou un graphique, l'information
affichée comprend la taille de I'objet et son emplacement.

Zoom ( 100% )
Pour modifier le grossissement de l'affichage, tirez le curseur de Zoom ou cliquez sur les
signes + et -. Vous pouvez également faire un clic droit sur le pourcentage de niveau de zoom
pour sélectionner une valeur de grossissement ou double-cliquer pour ouvrir la boite de
dialogue Zoom & disposition des pages.

Créer des classeurs

Vous pouvez démarrer un nouveau document vierge dans Calc de plusieurs fagons.

* Depuis le menu du systéme d'exploitation, de la méme maniére dont vous démarrez les
autres programmes. Quand LibreOffice est installé sur votre ordinateur, dans la plupart des
cas, une entrée de menu pour chague composant est ajoutée a votre menu systéme. Si
vous utilisez un Mac, vous devriez voir l'icbne LibreOffice dans le dossier Applications.
Quand vous double-cliquez sur cette icbne, LibreOffice s'ouvre sur le Centre de démarrage
(Figure 13).

* Depuis le Démarrage rapide, que I'on peut trouver sous Windows, certaines distributions
Linux et (sous une forme légérement différente) avec Mac OS X. Le Démarrage rapide est
une icbne qui est placée dans la barre des taches ou dans le dock au cours du démarrage
du systeme, a condition que l'option soit cochée dans Outils > Options > LibreOffice >
Mémoire. Elle indigue que LibreOffice a été chargé et est prét a I'emploi.

Faites un clic droit sur I'icdbne de Démarrage rapide (Figure 12) dans la barre des taches
pour ouvrir un menu déroulant a partir duquel vous pouvez ouvrir un nouveau document,
ouvrir la boite de dialogue Modéles et documents, ou choisir un document existant a ouvrir.
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Vous pouvez également double-cliquer sur l'icone de Démarrage rapide pour afficher la
boite de dialogue Gestionnaire de modeles.

Voyez Chapitre 1 (Présentation de LibreOffice) dans le Guide du débutant pour plus
d'informations sur l'utilisation du Démarrage rapide.

% Texte

Classeur

Présentation

Deszin

Baze de données

@ Formule

@ A partir d'un modéle...

. Quvrir un document...

v Charger LibreOffice au démarrage du systéme

Quitter le démarrage rapide

Figure 12 : Menu déroulant du Démarrage rapide avec Windows Vista

* Depuis le Centre de démarrage. Quand LibreOffice est actif, mais qu'aucun document
n'est ouvert (par exemple, si vous fermez tous les documents ouverts mais laissez le
programme en cours), le Centre de démarrage est affiché. Cliquez sur I'une des icbnes
pour ouvrir un nouveau document de ce type, ou cliquez sur l'icbne Modéles pour créer un
nouveau document en utilisant un modeéle.

D LibreOffice

The Document Foundation

A A

h Dessin
. -]

Classeur B Base de données
A A

Présentation Formule

E Ouvrir... hd T?E Modéles...

[P

Figure 13 : Centre de Démarrage LibreOffice
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Si un document est déja ouvert dans LibreOffice, le nouveau document s'ouvre dans une nouvelle
fenétre.

Quand LibreOffice est ouvert, vous pouvez également créer un nouveau document de l'une des
facons suivantes :

* Appuyez sur les touches Ctrl+N.
¢ Utilisez Fichier > Nouveau > Classeur.
* Cliquez sur le bouton Nouveau dans la barre d'outils Standard.

Créer un nouveau document depuis un modele

Les documents Calc peuvent également étre créés depuis des modeéles. Suivez les procédures ci-
dessus, mais au lieu de choisir Classeur, choisissez l'icbne Modéles depuis le Centre de
démarrage ou Fichier > Nouveau > Modeéles depuis la barre de menus ou la barre d'outils.

Dans la fenétre Gestionnaire de modéles, sélectionnez l'onglet Classeurs, naviguez jusqu'au
dossier approprié et double-cliquez sur le modeéle choisi (Figure 14). Un nouveau classeur, basé
sur le modéle sélectionné, s'ouvre.

Une nouvelle installation LibreOffice ne contient pas beaucoup de modeles, mais vous pouvez en
ajouter en les téléchargeant depuis http.//templates.libreoffice.org/ et en les installant.

Voir Chapitre 4 (Utiliser les styles et les modéles dans Calc) pour plus d'informations sur les
modéles.

i &)

G Gestionnaire de modéles EI@
Documents Classeurs |F' résentations IDessin5|

(Bl Editer 6 Propriétés | | Définir par defaut g Déplacer vers le dossier ~ | = Exporter ® Supprimer

‘ Tous les modeles Mes modéles ‘

Ex_Modl

Figure 14 : Créer un nouveau classeur depuis un modeéle

16 Introduction a Calc


http://templates.libreoffice.org/template-center

Ouvrir des classeurs existants

Quand aucun document n'est ouvert, le Quvrir |'exp|0r’ateur de fichiers

Centre de démarrage (Figure 13) comporte \
une icone pour ouvrir un document existant
et la liste des derniers documents utilisés. - Ouvrir... v

) . Ouvrir la liste des documents recemment utilisés
Vous pouvez aussli ouvrir un document

existant de I'une des fagons suivantes :
* Choisissez Fichier > Ouvrir.
* Cliquez sur le bouton Ouvrir dans la barre d'outils Standard.
* Appuyez Ctrl+O sur le clavier.

* Utilisez Fichier > Derniers documents utilisés pour afficher les 10 derniers fichiers qui
ont été ouverts par I'un des composants LibreOffice.

¢ Utilisez la sélection Ouvrir un document dans le Démarrage rapide.

Dans tous les cas, la boite de dialogue Ouvrir apparait. Sélectionnez le fichier que vous désirez,
puis cliguez sur Ouvrir. Si un document est déja ouvert dans LibreOffice, le second document
s'ouvre dans une nouvelle fenétre. Si vous cochez En lecture seule, le fichier sera ouvert
uniqguement en lecture, la mention (lecture seule) apparaitra a la suite du nom du fichier dans la
barre de titre et vous ne pourrez faire aucune modification.

Vous pouvez également ouvrir un fichier en le double-cliquant depuis I'explorateur de votre
systeme d'exploitation. Si vous avez associé les formats de fichier Microsoft Office a LibreOffice,
vous pouvez également ouvrir ces fichiers en les double-cliquant.

Ouvrir des fichiers CSV

Les fichiers Comma-Separated-Values (CSV) sont des fichiers texte qui comportent une seule
feuille de contenus de cellules. Chaque ligne d'un fichier CSV représente une ligne d'une feuille de
calcul. Les virgules, les points-virgules ou d'autres caractéres sont utilisés pour séparer les
cellules. Le texte peut étre saisi entre des guillemets ; les nombres sont saisis sans guillemets.

Pour ouvrir un fichier CSV dans Calc :

1) Choisissez Fichier > Ouvrir.

2) Repérez le fichier CSV que vous voulez ouvrir. Vous pouvez sélectionner Texte CSV (*csv)
dans la liste déroulante Type de fichier (descendez dans la partie tableur pour la trouver)
pour restreindre l'affichage aux fichiers ayant comme extension *.csv.

3) Sélectionnez le fichier et cliguez sur Ouvrir.

4) Dans la boite de dialogue Import de texte (Figure 15), sélectionnez les Options de
séparateur pour diviser le texte du fichier en colonnes.
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Import de texte - [reg2011.csv]

Importer
Jeu de caractéres Europe occidentale (Windows-1252/WinLatin 1|Z|
Langue Par défaut - Frangais (France) |Z|
A partir de la ligne 1 =

Options de séparateur

Largeur fixe

@) Séparé par

| Tabulation Virgule Autres
| Point-virgule Espace
Fusicnner les séparateurs Séparateur de texte "

Autres options

JiChamp entre guillemets comme texte!

Détecter les nombres spéciaux

Champs

Standard |Standard

EGION HNOM

Guadeloupe
Martinigue

Guyane

La Réunion
ile-de-France
Champagne-Ardenne

==

Y B =) L ) = Y )

I

m

S

Aide |

EX3

Annuler |

Figure 15 : Boite de dialogue Import de texte, avec le point-virgule et la tabulation comme

séparateurs de colonne et le guillemet comme séparateur de texte

5) Vous pouvez prévisualiser la mise en forme des données importées en bas de la boite de
dialogue. Faites un clic droit sur la colonne dans la prévisualisation pour déterminer le

format ou masquer (ne pas importer) la colonne.

Si le fichier CSV utilise un caractére de séparation de texte qui ne se trouve pas dans la
liste des Séparateurs de texte, cliquez dans la zone et saisissez le caractére.

6) Les options de la section Autres options déterminent si les données entre guillemets seront
toujours importées en tant que texte, et si Calc doit automatiquement détecter tous les
formats numériques, y compris les formats numériques spéciaux comme les dates, les
heures ou la notation scientifique. La détection dépend des parametres de langues : par
exemple en francais de France, la virgule est interprétée comme séparateur décimal et le
point comme séparateur de date ; si un point est utilisé comme séparateur décimal, veillez
a modifier la Langue (par exemple Anglais (U.S.A.)). Vous pouvez modifier les formats de
date automatiquement reconnus dans la boite de dialogue Outils > Options > Paramétres

linguistiques > Langues option Motifs d’acceptation de date.
7) Cliquez sur OK pour ouvrir le fichier.

La méthode ci-dessus fonctionne également avec les fichiers TXT.

18
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Attention [a méthode d'ouverture des fichiers CSV est propre au module Calc. Si vous ouvrez
un fichier *.csv ou *.txt avec un autre composant de LibreOffice (Writer par exemple),
le comportement sera différent.

Fermer les classeurs

Pour fermer un classeur, vous pouvez cliquer la croix en haut a droite de la fenétre ou choisir
Fichier > Fermer dans la barre de menus. S'il existe des maodifications non encore enregistrées
dans votre classeur, un message apparaitra, vous demandant si vous voulez enregistrer le
classeur, le fermer sans enregistrer ou annuler et revenir dans le classeur.

Si vous voulez quitter LibreOffice, vous pouvez choisir Fichier > Quitter LibreOffice dans la barre
de menus, ou appuyer sur les touches Ctrl+Q. Chaque document sera fermé, ainsi que
I'application LibreOffice. Un message apparaitra pour chaque document comportant des
modifications non enregistrées.

Enregistrer les classeurs

Les classeurs peuvent étre enregistrés de trois maniéres :

* Appuyez sur Ctrl+S.
* Choisissez Fichier > Enregistrer (ou Tout enregistrer ou Enregistrer sous).

* Cliquez sur le bouton Enregistrer de la barre d'outils Standard.
Si le classeur n'a pas encore été sauvegardé précédemment, alors chacune de ces actions ouvrira

la boite de dialogue Enregistrer sous. Vous pourrez alors spécifier le nom du classeur et
I'emplacement du stockage.

Si le classeur a été enregistré précédemment, alors l'enregistrer en utilisant la
commande Enregistrer (ou Tout enregistrer) va écraser la version existante.
Toutefois, vous pouvez enregistrer le classeur a un emplacement différent ou avec
un nom différent en sélectionnant Fichier > Enregistrer sous.

Note

Enregistrer en tant que document Microsoft Excel

Certains utilisateurs de Microsoft Excel peuvent ne pas souhaiter ou étre incapables de recevoir
des fichiers *.ods. Dans ce cas, vous pouvez enregistrer un document en tant que fichier Excel
(*.xls ou *.xlsx).

1) Important — Enregistrez tout d'abord votre classeur dans le format de fichier utilisé par
LibreOffice, *.ods. Si vous ne le faites pas, toutes les modifications que vous aurez pu
effectuer depuis le moment de votre dernier enregistrement apparaitront uniguement dans
la version Microsoft Excel du document.

2) Puis choisissez Fichier > Enregistrer sous.

3) Dans la boite de dialogue Enregistrer sous (Figure 16), dans le menu déroulant Type de
fichier, sélectionnez le type de format Excel dont vous avez besoin. Cliquez sur
Enregistrer.
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Enregistrer sous ==

E0O0oDocs B
Emplacements Titre Type |Tai||e |Dated
m |':| EszzaiCC Dossier 08,02/

T estim-pop-reg-sca-1990-201 Document MS Excel 1675 Ko 09/05/:
][]

MNom de fichier : Test Calc1 [ Enregistrer l
Type de fichier: ’ Annuler ]
Claszeur QDF (,ods) -

Maodéle de classeur QDF (,ots) ’ Aide ]

OpenOffice.org 1.0 Classeur (.sxc)

[] Enregistrer avec nOpenOffice.org 1.0 Modéle de classeur (.ste)
OpenDocument Spreadsheet (Flat ML) (fods)
Unified Office Format spreadsheet ((uos)
Microsoft Excel 200772010 XML (axlsx)
Microsoft Excel 2003 XML (xml)

Microsoft Excel 97/2000/XP/2003 (xls)

Modéle Microsoft Excel 97/2000/XP/2003 (.xlt) -
Figure 16 : Enregistrer un classeur au format Microsoft Excel

m

er

Editer les paraméy

4) Il est possible que le message suivant apparaisse. Cliquez sur Utiliser le format
Microsoft Excel ... correspondant au format que vous avez choisi.

Confirmer le format de fichier @

Ce document contient des formatages ou du contenu qui ne peut pas étre enregistré dans le
@ format de fichier "Microsoft Excel 2007,/2010 XML" actuellement sélectionné,

Utiliser le format de fichier ODF par défaut afin d'assurer un enregistrement correct du
document.

[ Wtiliser le format Microsoft Excel 2007/2010 XML l ’ Utiliser le format ODF

Demander lors d'un enregistrernent autre que dans le format ODF

; A partir de ce moment, toutes les modifications que vous apporterez au classeur
Attention . . . .
auront lieu uniquement dans le document Microsoft Excel. Vous avez changé le
nom et le type de fichier de votre document. Si vous voulez revenir en arriere pour
travailler avec la version *.ods de votre classeur, vous devez I'ouvrir a nouveau.
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Pour que Calc enregistre par défaut vos documents dans un format Microsoft
Excel, allez a Outils > Options > Chargement/enregistrement > Général. Dans

Astuce la section intitulée Format de fichier par défaut et paramétrages ODF, sous Type
de document, sélectionnez Classeur, puis sous Enregistrer systématiquement
sous, sélectionnez votre format de fichier préféré.

Enregistrer en tant que fichier CSV

Pour enregistrer un classeur en tant que fichier CSV :
1) Choisissez Fichier > Enregistrer sous.
2) Dans le champ Nom du fichier, tapez le nom du fichier.

3) Dans la liste Type de fichier, sélectionnez Texte CSV (*.csv) et cliquez sur Enregistrer. ||
est possible que le message suivant apparaisse. Cliquez sur Utiliser le format Texte CSV.

Confirmer le format de fichier (3]

Ce document contient des formatages ou du contenu qui ne peut pas
étre enregistré dans le format de fichier "Texte TSV actuellement
selecticnné,

Utiliser le format de fichier ODF par défaut afin d'assurer un
enregistrement correct du document.

R R Y e, T ] | Latikeenle oot ORE

| Demander lors d'un enregistrement autre que dans le format ODF

4) Dans la boite de dialogue Export de fichier texte, sélectionnez les options que vous voulez
et cliquez ensuite sur OK.

Export de fichiers texte @
Options de champ [ ok l
leu de caractéres
Séparateur de champ |, |Z| | &bnuler |
Séparateur de texte " |Z| | Aide |

/| Enregistrer le contenu de la cellule comme affiché
Enregistrer les formules de cellule au lieu des valeurs calculées
Mettre entre guillemets toutes les cellules de texte

Largeur de colonne fixe

Figure 17 : Choix des options lors de I'export en Texte CSV

Enregistrement dans d'autres formats

Calc peut enregistrer des classeurs dans une variété de formats, dont HTML (pages Web), a
travers la boite de dialogue Enregistrer sous. Calc peut également exporter des classeurs vers les
formats de fichier PDF et XHTML. Voir Chapitre 6 (Imprimer, exporter et envoyer par e-mail).
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Protection par mot de passe

Calc fournit deux niveaux de protection de document : protection en lecture (le fichier ne peut étre
visualisé sans mot de passe) et protection en écriture (le fichier peut étre affiché en mode lecture
seule, mais ne peut étre modifié sans mot de passe). De plus, vous pouvez rendre le contenu
accessible en lecture pour un groupe de personnes sélectionné et en lecture et en écriture pour un
autre groupe. Ce comportement est compatible avec la protection de fichier Microsoft Excel.

1) Utilisez Fichier > Enregistrer sous pour enregistrer le document. (Vous pouvez

2)

Mom de fichier

Type de fichier:

également utiliser Fichier > Enregistrer la premiéere fois que vous enregistrez un nouveau
document.)

Dans la boite de dialogue Enregistrer sous, tapez le nom du fichier, sélectionnez 'option
Enregistrer avec mot de passe et cliguez sur Enregistrer.

3) La boite de dialogue Définir le mot de passe s'ouvre.

Definir le mot de passe @

Mot de passe de chiffrernent de fichier

Saisir un mot de passe d'ouverture

Confirmer le mot de passe

Remarque : aprés qu'un mot de passe ait éte défini, le
document ne s'ouvrira qu'avec celui-ci

............................................. oK | | Annuler

Mot de passe de partage de fichier

Cuvrir le fichier en lecture seule

Saisir un mot de passe pour permettre |'édition

Confirmer le mot de passe

Figure 18 : Deux niveaux de protection par mot de passe

Calc testl [ Enregistrer l
Classeur ODF (iods) IZ” I Arnnuler ‘
| Aide |
éEnregistrer avec mot de passe! Bxtensicn automatique du nem de fichier

22

Introduction a Calc



Vous avez ici plusieurs options :
. Pour protéger le document en lecture, tapez un mot de passe dans les deux champs
en haut de la boite de dialogue.

. Pour protéger le document en écriture, cliquez sur le bouton Plus d'options et
sélectionnez la case a cocher Ouvrir le fichier en lecture seule.

. Pour protéger le document en écriture mais permettre a des personnes sélectionnées
de le modifier, sélectionnez la case a cocher Ouvrir le fichier en lecture seule et
tapez un mot de passe dans les deux champs en bas de la boite de dialogue.

5) Cliquez sur OK pour enregistrer le fichier. Si I'une des paires de mots de passe n'est pas
cohérente, vous recevrez un message d'erreur. Fermez la boite de message pour retourner
a la boite de dialogue Définir le mot de passe et entrer a nouveau le mot de passe.

Attenj pel LibreOffice utilise un mécanisme de chiffrement trés puissant qui rend impossible

la récupération du contenu d'un document si vous perdez le mot de passe.

Naviguer dans les classeurs

Calc propose plusieurs fagons de naviguer a l'intérieur d'un classeur, de cellule a cellule et de
feuille & feuille. Vous pouvez en général utiliser la méthode que vous préférez.

Aller vers une cellule particuliére

Utiliser la souris
Placez le pointeur de la souris sur la cellule et cliquez.

Utiliser une référence de cellule
Cliquez sur le petit triangle noir renversé situé juste a droite de la Zone de nom (Figure 8). La
référence de cellule actuelle sera en surbrillance. Tapez la référence de la cellule ou vous
voulez aller et appuyez sur Entrée. Les références de cellules sont insensibles a la casse : a3
ou A3, par exemple, sont identiques. Ou cliquez simplement dans la Zone de nom, faites un
retour arriere sur la référence de cellule existante, tapez la référence de cellule que vous
voulez et appuyez sur Entrée.

Utiliser le Navigateur
Cliquez sur le bouton Navigateur de la barre d'outils Standard (ou appuyez sur F5) pour
afficher le Navigateur. Tapez la référence de cellule dans les deux champs du haut, intitulés
Colonne et Ligne, et appuyez sur Entrée. Dans la Figure 33 page 38, le Navigateur
sélectionnera la cellule B4. Pour plus d'informations sur l'utilisation du Navigateur, voir page
38.

Se déplacer de cellule a cellule

Dans le classeur, une des cellules a nhormalement une bordure noire plus sombre. Cette bordure
noire indique ou se trouve le focus (voir Figure 19). Le focus indique quelle cellule est activée pour
recevoir une entrée. Si un groupe de cellules est sélectionné, elles ont une couleur de surbrillance
(habituellement bleu), avec la cellule du focus qui a une bordure sombre.
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Figure 19 : Une cellule avec focus (gauche) et un groupe de cellules sélectionnées (droite)

Utiliser la souris
Pour déplacer le focus en utilisant la souris, déplacez simplement le pointeur de la souris sur la
cellule ou vous voulez le focus et cliquez sur le bouton gauche de la souris. Cette action
déplace le focus vers la nhouvelle cellule. Cette méthode est la plus utile quand les deux
cellules sont éloignées.

Utiliser les touches Tab et Entrée
* Appuyer sur Entrée ou Maj+Entrée déplace le focus vers le bas ou vers le haut,
respectivement.

* Appuyer sur Tab ou Maj+Tab déplace le focus vers la droite ou vers la gauche,
respectivement.

Utiliser les touches fleches
Appuyer sur les touches fléeches du clavier déplace le focus dans la direction des fléches.

Utiliser Début, Fin, Page précédente et Page suivante
e Début (\) déplace le focus au début d'une ligne.

* Fin déplace le focus vers la colonne la plus a droite qui contient une donnée.

* Page suivante (PgSuiv) déplace I'affichage d'un écran complet vers le bas et Page
précédente (PgPrec) déplace l'affichage d'un écran complet vers le haut.

* Les combinaisons de Contréle (souvent représenté sur les claviers par Ctrl) et Alt avec
Début, Fin, Page précédente, Page suivante et les touches fleches déplacent le focus
depuis la cellule courante de manieres différentes. Le Tableau 1 décrit les raccourcis
clavier pour se déplacer dans un classeur.

Astuce Utilisez Alt+ -~ ou Alt+ — pour augmenter ou diminuer la largeur d'une cellule.

Tableau 1. Se déplacer de cellule a cellule en utilisant le clavier

Combinaison de Mouvement

touches

N Une cellule sur la droite
- Une cellule sur la gauche
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Combinaison de
touches

1

!

Mouvement

Une cellule vers le haut

Une cellule vers le bas

Ctrl+ - Vers la colonne suivante sur la droite contenant une donnée sur cette
ligne ou vers la colonne AMJ

Ctrl+ ~ Vers la colonne suivante sur la gauche contenant une donnée sur cette
ligne ou vers la colonne A

Ctrl+1 Vers la ligne suivante vers le haut contenant une donnée dans cette
colonne ou vers la ligne 1

Ctrl+ Vers la ligne suivante vers le bas contenant une donnée dans cette
colonne ou vers la ligne 1 048 576

Ctri+~ Vers la cellule Al

Ctrl+Fin Vers le coin inférieur droit de la zone rectangulaire qui contient des
données

Alt+PgSuiv Un écran sur la droite (si possible)

Alt+PgPrec Un écran sur la gauche (si possible)

Ctrl+PgSuiv Une feuille sur la droite (dans les onglets)

Ctrl+PgPrec Une feuille sur la gauche (dans les onglets)

Tab Vers la prochaine cellule sur la droite

Maj+Tab Vers la prochaine cellule sur la gauche

Entrée Une cellule vers le bas (sauf changement par l'utilisateur)

Maj+Entrée Une cellule vers le haut (sauf changement par l'utilisateur)

Personnaliser les effets de la touche Entrée

Vous pouvez personnaliser la direction dans laquelle la touche Entrée déplace le focus, en
sélectionnant Outils > Options > LibreOffice Calc > Général.

Les quatre options pour la direction de la touche Entrée sont indiquées sur la droite de la Figure
20. On peut déplacer le focus en bas, a droite, en haut ou a gauche. Selon le fichier utilisé ou le
type de données a saisir, paramétrer une direction différente peut étre utile.

Parameétres de saisie

| Touche Entrée pour déplacer |a sélection

Touche Entrée pour basculer dans le mode Edition :
A droite

Etendre le formatage En haut
£ gauche

Etendre les références lors de l'insertion de colonnes/lignes

| Mettre en évidence la sélection dans les en-tétes de lignes/colonnes

Figure 20 : Personnaliser les effets de la touche Entrée

La touche Entrée peut également étre utilisée pour basculer dans et hors du mode édition. Utilisez
les deux premiéres options sous Parameétres de saisie dans la Figure 20 pour modifier le
paramétrage de la touche Entrée.
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Se déplacer de feuille a feuille

Chaque feuille dans un classeur est indépendante des autres, bien qu'elles puissent étre liées par
des références d'une feuille & I'autre. 1l y a trois fagons de naviguer entre les différentes feuilles
d'un classeur.

Utiliser le clavier
Appuyer sur Ctrl+Page suivante permet de se déplacer d'une feuille vers la droite et appuyer
sur Ctrl+Page précédente permet de se déplacer d'une feuille vers la gauche.

Utiliser la souris
Cliquer sur un des onglets en bas du classeur permet de sélectionner la feuille
correspondante.

Si vous avez beaucoup de feuilles, certains des onglets peuvent alors étre cachés derriere la
barre de défilement horizontal en bas de I'écran. Si c'est le cas, les quatre boutons a la gauche
des onglets peuvent alors faire apparaitre les onglets cachés. La Figure 21 montre comment le
faire.

Les fleches des onglets qui apparaissent Figure 21 apparaissent seulement si
Note vous avez des onglets qui ne sont pas visibles. Sinon, elles apparaissent en grisé
comme Figure 1.

Vers la premiéere feuille

Une feuille vers la gauche

Une feuille vers la droite

Vers la derniére feuille

Onglets des feuilles

[14](«][» ][»1] { Feuilled ; Feuille7 / Feuille3 / Feuill | <
Feuillle d /7

Figure 21 : Fléches de tabulation des feuilles

Utiliser le navigateur
Dans le navigateur, cliquez sur le symbole + a cété de Feuilles pour voir la liste des feuilles du
classeur. Double-cliquez sur la feuille & atteindre. Pour plus de détails, voir Utiliser le
Navigateur page 38.

Notez que les feuilles ne sont pas numérotées dans l'ordre. La numérotation des feuilles est
arbitraire ; vous pouvez nommer une feuille comme vous le voulez. La barre d'état de la Figure 21
indique que Feuille7 est en quatrieme position parmi les sept feuilles du classeur.

Sélectionner des éléments dans une feuille ou un classeur

Sélectionner des cellules

Les cellules peuvent étre sélectionnées dans une variété de combinaisons et de quantités.
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Cellule individuelle

Pour sélectionner une cellule individuelle, celle-ci doit avoir le focus, comme indiqué page 23. Le
résultat ressemblera a la partie gauche de la Figure 19. Vous pouvez vérifier en regardant dans la
Zone de nom. Faites ensuite un Ctrl+Clic gauche dans la cellule qui sera mise en surbrillance.

Plage de cellules contigués
Une plage de cellule peut étre sélectionnée en utilisant le clavier ou la souris.

Pour sélectionner une plage de cellules en faisant glisser la souris :

1) Cliquez dans une cellule.
2) Appuyez et gardez appuyé le bouton gauche de la souris.
3) Déplacez la souris sur I'écran.
4) Une fois que le bloc de cellules souhaité est en surbrillance, relachez le bouton gauche de
la souris.
Pour sélectionner une plage de cellules sans faire glisser la souris :
1) Cliguez dans la cellule qui sera un des coins de la plage de cellules.
2) Déplacez la souris dans le coin opposé de la plage de cellules.
3) Gardez appuyée la touche Maj et cliquez.

Vous pouvez également sélectionner une plage de cellules contigués en cliquant
tout d'abord dans le champ Mode sélection de la barre d'état et en le changeant
en Sélection étendue, avant de cliquer sur le coin opposé de la plage de cellules
lors de I'étape 3 ci-dessus. Si vous utilisez cette méthode, assurez-vous de
rechanger Sélection étendue en Sélection standard ou vous risquez d'étendre la
sélection involontairement.

Astuce

Pour sélectionner une plage de cellules sans utiliser la souris :
1) Sélectionnez la cellule qui sera un des coins de la plage de cellules.

2) En gardant appuyée la touche Maj, utilisez les fleches du curseur pour sélectionner le reste
de la plage.

Le résultat de I'une de ces méthodes ressemblera au c6té droit de la Figure 19.

Vous pouvez également sélectionner directement une plage de cellules en utilisant
la Zone de nom. Cliquez dans la Zone de nom comme décrit dans “Utiliser une
référence de cellule” page 23. Pour sélectionner une plage de cellules, saisissez la
référence de cellule du coin supérieur gauche, suivi de deux points (:), et ensuite
de la référence de cellule du coin inférieur droit. Par exemple, pour sélectionner la
plage qui va de A3 a C6, vous saisiriez A3:C6.

Astuce

Plage de cellules non contigués
1) Sélectionnez la cellule ou la plage de cellules en utilisant une des méthodes ci-dessus.

2) Déplacez le pointeur de la souris vers le début de la prochaine plage ou cellule individuelle.

3) Gardez appuyée la touche Ctrl et cliquez ou cliquez et faites glisser pour sélectionner une
autre plage de cellules a ajouter a la premiére plage.

4) Répétez autant que nécessaire.
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Vous pouvez également sélectionner une plage de cellules non contigués en
cliguant tout d'abord dans le champ Mode sélection de la barre d'état et en le
changeant en Sélection avec ajout, avant de cliquer dans la cellule que vous

Astuce voulez ajouter a la plage de cellules dans I'étape 3 ci-dessus. Cette méthode est
meilleure pour ajouter des cellules individuelles a une plage. Si vous utilisez cette
méthode, assurez-vous de rechanger Sélection avec ajout en Sélection standard
OU VOUS pourrez vous retrouver a ajouter des sélections involontairement.

Sélectionner des colonnes et les lignes

Les colonnes et les lignes entiéres peuvent étre sélectionnées trés rapidement dans LibreOffice.

Colonne ou ligne individuelle
Pour sélectionner une colonne individuelle, cliquez sur la lettre identifiant la colonne (voir Figure 1).

Pour sélectionner une ligne individuelle, cliquez sur le numéro identifiant la ligne.

Colonnes ou lignes multiples
Pour sélectionner des colonnes ou lignes multiples qui sont contigués :

1) Cliguez sur la premiére colonne ou ligne du groupe.
2) Gardez appuyée la touche Maj.
3) Cliquez sur la derniére colonne ou ligne du groupe.

Pour sélectionner des colonnes ou lignes multiples qui ne sont pas contigués :
1) Cliguez sur la premiére colonne ou ligne du groupe.
2) Gardez appuyée la touche Citrl.
3) Cliquez sur toutes les colonnes ou lignes suivantes en gardant appuyée la touche Citrl.

Feuille entiére
Pour sélectionner la feuille entiére, cliquez dans la petite boite entre I'en-téte de colonne A et I'en-
téte de ligne 1. Vous pouvez également appuyer sur Ctrl+A pour sélectionner la feuille entiere.

u -

A I'“‘H Tout sélectionner

=

Figure 22 : Boite Tout sélectionner

Sélectionner des feuilles

Vous pouvez sélectionner une ou plusieurs feuilles. Il peut étre intéressant de sélectionner
plusieurs feuilles en méme temps si vous voulez effectuer des modifications dans plusieurs feuilles
en une seule fois.

Feuille individuelle
Cliquez sur l'onglet de la feuille que vous voulez sélectionner. L'onglet de la feuille active devient
blanc (voir Figure 21).
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Plusieurs feuilles contigués
Pour sélectionner plusieurs feuilles contigués :

1) Cligquez sur l'onglet de la premiére feuille désirée.
2) Déplacez le pointeur de la souris sur l'onglet de la derniére feuille désirée.
3) Gardez appuyée la touche Maj et cliquez sur l'onglet.

Tous les onglets entre ces deux feuilles deviennent blancs. Toute action que vous ferez affectera
désormais toutes les feuilles en surbrillance.

Plusieurs feuilles hon contigués
Pour sélectionner plusieurs feuilles non contigués :

1) Cliguez sur l'onglet de la premiére feuille désirée.

2) Déplacez le pointeur de la souris sur l'onglet de la deuxiéme feuille désirée.
3) Gardez appuyée la touche Ctrl et cliquez sur l'onglet.

4) Répétez autant que nécessaire.

Les onglets sélectionnés deviennent blancs. Toute action que vous ferez affectera désormais
toutes les feuilles en surbrillance.

Toutes les feuilles
Faites un clic droit sur I'un des onglets et choisissez Sélectionner toutes les feuilles dans le
menu déroulant.

Si une couleur d'onglet a été définie pour une feuille, lorsque cette feuille est
Note sélectionnée, la couleur n'apparait qu'en bas de l'onglet et le reste de la zone
devient blanc.

Attention Une fois les modifications effectuées sur les différentes feuilles, pensez a revenir a
une seule feuille sélectionnée, sinon vos modifications continueront a s’appliquer a
toutes les feuilles. Pour cela, cliquez sur I'onglet d’'une feuille non sélectionnée.

Actions sur les colonnes et les lighes

Insérer des colonnes et des lighes

Les colonnes et les lignes peuvent étre insérées individuellement ou en groupes.

Quand vous insérez une colonne individuelle, elle est insérée a la gauche de la
colonne en surbrillance. Quand vous insérez une ligne individuelle, elle est insérée
au-dessus de la ligne en surbrillance.

Les cellules des nouvelles colonnes ou lignes sont formatées comme les cellules
correspondantes de la colonne ou de la ligne avant (ou a gauche de) la nouvelle
colonne ou ligne insérée.

Note

Colonne ou ligne individuelle
Utiliser le menu Insertion :

1) Sélectionnez la cellule, colonne ou ligne ou vous voulez insérer la nouvelle colonne ou
ligne.

2) Choisissez Insertion > Colonnes ou Insertion > Lignes.
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Utiliser la souris :
1) Sélectionnez la cellule, colonne ou ligne ou vous voulez insérer la nouvelle colonne ou
ligne.
2) Faites un clic droit sur I'en-téte de colonne ou de ligne.
3) Choisissez Insérer des lignes ou Insérer des colonnes.

Colonnes ou lignes multiples
Les colonnes ou lignes multiples peuvent étre insérées en une fois plutét que une par une.

1) Mettez en surbrillance le nombre voulu de colonnes et de lignes en gardant appuyé le
bouton gauche de la souris sur la premiére et ensuite en le faisant glisser sur le nombre
voulu d'identifiants.

2) Procédez comme pour insérer une seule colonne ou lighe comme ci-dessus.

Supprimer des colonnes et des lighes

Les colonnes et les lignes peuvent étre supprimées individuellement ou par groupes.

Colonne ou ligne individuelle
Une colonne ou ligne individuelle peut étre supprimée en utilisant la souris :

1) Sélectionnez la colonne ou la ligne a supprimer.
2) Choisissez Edition > Supprimer des cellules depuis la barre de menus.
Ou,

1) Faites un clic droit sur I'en-téte de la colonne ou de la ligne.
2) Choisissez Supprimer des colonnes ou Supprimer des lignes dans le menu déroulant.

Colonnes ou lignes multiples
Les colonnes ou lignes multiples peuvent étre supprimées en une fois plutdét que une par une.

1) Mettez en surbrillance le nombre voulu de colonnes ou de lignes en gardant appuyé le
bouton gauche de la souris sur la premiére et ensuite en le faisant glisser sur le nombre
voulu d'identifiants.

2) Procédez comme pour supprimer une seule colonne ou ligne comme ci-dessus.

Au lieu de supprimer une ligne ou une colonne, vous pouvez souhaiter supprimer
Astuce les contenus des cellules, mais garder la ligne ou la colonne vide. Voir Chapitre 2
(Saisir, modifier et formater les données) pour instructions.

Actions sur les feuilles

Comme tous les autres éléments de Calc, les feuilles peuvent étre insérées, supprimées et
renommeées.

Insérer de nouvelles feuilles

Il'y a plusieurs facons d'insérer une nouvelle feuille. La méthode la plus rapide est de cliquer sur le

bouton Ajouter une feuille =/, Elle insére une nouvelle feuille a cet endroit, sans ouvrir la boite

de dialogue Insérer une feuille.

Utilisez I'une des autres méthodes pour insérer plus d'une feuille, pour renommer en méme temps
la feuille ou pour insérer la feuille ailleurs dans la séquence. La premiéere étape pour toutes ces
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méthodes est de sélectionner les feuilles prés desquelles la nouvelle feuille va étre insérée. Puis

utilisez I'une des options suivantes.

* Choisissez Insertion > Feuille depuis la barre de menus.
* Faites un clic droit sur l'onglet et choisissez Insérer une feuille.
* Cliquez sur un espace vide a la fin de la ligne des onglets.

Cliquez ici pour insérer une nouvelle
feuille sans ouvrir la boite de
dialogue Insérer une feuille

Cliquez ici pour insérer une nouvelle
feuille et ouvrir la boite de
dialogue Insérer une feuille

", Feuillel fFeuiII&B\FEM

Figure 23 : Créer une nouvelle feuille

Chaque méthode ouvrira une boite de dialogue Insérer une feuille (Figure 24). La, vous pouvez
déterminer si la nouvelle feuille sera positionnée avant ou apres la feuille sélectionnée et le
nombre de feuilles que vous voulez insérer. Si vous insérez une seule feuille, vous avez la

possibilité ici de lui donner un nom.

Insérer une feuille

Position

@ fyvant la feuille actrve!

Apres |a feuille active

Feuille
@ MNouvelle feuille

Mombre de feuilles |1
Mam Feuilled

A partir d'un fichier

=)

Lo ]

| Annuler |

| Aide |

Figure 24 : Boite de dialogue Insérer une feuille

Vous pouvez fixer le nombre de feuilles des houveaux documents en sélectionnant
Astuce Outils > Options > LibreOffice Calc > Par défaut. Par défaut, une seule feuille
de calcul est créée lors de la création d'un nouveau document.

Renommer des feuilles

Le nom par défaut d'une nouvelle feuille est aaaX, ou aaa est le préfixe défini dans Outils >

Options > LibreOffice Calc > Par défaut (Feuille par défaut) et X est un numéro. Si cela convient

pour un petit classeur avec seulement quelques feuilles, cela devient moins lisible lorsqu'il y en a

beaucoup.
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Pour donner & une feuille un nom plus significatif, vous pouvez :

* saisir le nom dans la Zone de nom quand vous créez la feuille ;

* faire un clic droit sur I'onglet et choisir Renommer la feuille dans le menu déroulant ;
remplacer le nom existant par un nouveau.

e faire Alt+Clic sur I'onglet pour y modifier directement le nom ;
* double-cliquer sur l'onglet pour ouvrir la boite de dialogue Renommer la feuille.

Les noms de feuilles peuvent contenir presque n'importe quel caractere hormis
guelques caractéres spéciaux (entre autres \/ :? *[]). Certaines restrictions de

Note nom s'appliquent lorsque vous souhaitez enregistrer le classeur au format
Microsoft Excel. Une tentative de renommer une feuille avec un nom incorrect
produira un message d'erreur.

Déplacer et copier des feuilles

Sélectionnez tout d'abord la feuille que vous voulez déplacer ou copier. Vous pouvez ensuite soit
faire un clic droit sur l'onglet de la feuille et choisir Déplacer/Copier la feuille, soit choisir Edition
> Feuille > Déplacer/copier depuis la barre de menus. La boite de dialogue Déplacer/copier la
feuille apparait (Figure 25).

Déplacer/copier la feuille [£5]

Action

Emplacement

Vers le document

|Sar‘|5 noml (document actif) IZ”

Insérer avant

Feuillel

Feuille2
Feuille3
- placer en derniére position -

Mom

Mouveau nom

Feuillel

Aide | | ok || Annuler

Figure 25 : Boite de dialogue Déplacer/copier la feuille
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Action
Choisissez la case a cocher pour déplacer la feuille sélectionnée ou pour créer une nouvelle
feuille en copiant la feuille sélectionnée.

Vers le document
Permet de déplacer ou copier la feuille sélectionnée a l'intérieur du document (classeur) actif,
vers un autre document ouvert dans LibreOffice, ou vers un nouveau document.

Insérer avant
Permet d'indiquer, dans le classeur de destination, avant quelle feuille la feuille sélectionnée
doit étre déplacée ou copiée.

Nouveau hom
Permet de renommer la feuille déplacée ou créée par copie.

Si vous choisissez comme document de destination un autre classeur ouvert ou

Attention - nouveau document -, cela peut créer des conflits pour les formules liées a
d'autres feuilles du document d'origine. Si vous déplacez involontairement une
feuille, vous pouvez y remédier en déplagant ou copiant la feuille a son

emplacement d'origine.

Vous pouvez également déplacer une feuille a l'intérieur d'un classeur en cliquant sur son onglet et
en le faisant glisser vers son emplacement de destination. Deux petits triangles (voir Figure 26)
indiquent I'endroit ou la feuille sera déplacée. Le pointeur de la souris peut se transformer en un
symbole d'indication ; ceci dépend de votre systeme d'exploitation. Pour copier une feuille a
l'intérieur d'un classeur, procédez de la méme fagon tout en gardant la touche Ctrl appuyée.

29

o

wfuga Feuille3 (% /

Feuille 3 / 3 o
Figure 26 : Faire glisser une feuille pour la déplacer

Supprimer des feuilles

Les feuilles peuvent étre supprimées individuellement ou par groupes.

Feuille individuelle
Faites un clic droit sur lI'onglet que vous voulez supprimer et choisissez Supprimer la feuille
dans le menu contextuel, ou choisissez Edition > Feuille > Supprimer dans la barre de
menus. Dans tous les cas, un avertissement vous demandera si vous voulez supprimer la
feuille définitivement. Cliquez sur Oui.

Feuilles multiples
Pour supprimer des feuilles multiples, sélectionnez-les comme décrit auparavant, puis soit
faites un clic droit sur I'un des onglets et choisissez Supprimer la feuille dans le menu
contextuel, ou choisissez Edition > Feuille > Supprimer dans la barre de menus.

Afficher ou masquer des feuilles
Pour masquer une feuille, vous pouvez :

* faire un clic droit sur I'onglet de la feuille et choisir Masquer ;
* sélectionner la feuille et choisir Format > Feuille > Masquer dans la barre de menus.
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Pour afficher une feuille masquée, vous pouvez :

e faire un clic droit sur I'onglet d'une feuille quelconque et choisir Afficher ;
* choisir Format > Feuille > Afficher dans la barre de menus.

Dans chacun de ces cas, la boite de dialogue Afficher la feuille apparait, ot vous pouvez choisir
les feuilles que vous voulez afficher et cliquer sur OK.

La barre d'état indique le nombre total de feuilles, affichées ou masquées. En
Astuce comparant avec le nombre d'onglets, vous pouvez détecter la présence de feuilles
masquées.

Affichage de Calc

Utiliser le zoom
Utilisez le zoom pour changer l'affichage afin de montrer plus ou moins de cellules dans la fenétre.

En plus de l'utilisation du curseur de zoom dans la barre d'état (voir page 14), vous pouvez ouvrir
la boite de dialogue Zoom & disposition des pages et modifier le facteur de zoom.

* Choisissez Affichage > Zoom dans la barre de menus, ou
* Double-cliquez sur le pourcentage dans la barre d'état en bas de la fenétre.

i =

Zoom & disposition des pages |3

Facteur de zoom Disposition des pages

Edapterla largeur et la hauteur Une page

]

Variable [100%

oK ]| Annuler | | Aide

Figure 27 : Boite de dialogue Zoom & disposition des pages

Optimal
Redimensionne l'affichage pour correspondre a la largeur des cellules sélectionnées. Pour
utiliser cette option, vous devez tout d'abord mettre en surbrillance une plage de cellules.

Adapter la largeur et la hauteur
Affiche la page entiére sur votre écran.

Adapter a la largeur
Affiche la largeur compléte de la page du document. Les bords supérieur et inférieur de la
page peuvent ne pas étre visibles.

100 %
Affiche le document a sa taille initiale.

Variable
Entrez le pourcentage de zoom de votre choix.
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Fixer les lignes et les colonnes

Fixer verrouille un nombre de lignes au sommet de la feuille ou un nombre de colonnes a la

gauche de la feuille, ou les deux. Ceci effectué, quand vous vous déplacez dans la feuille, toutes

les colonnes et les lignes fixées restent affichées.

La Figure 28 montre des lignes et des colonnes fixées. La ligne horizontale plus épaisse entre les

lignes 8 et 17 et la ligne verticale plus épaisse entre les colonnes B et H indiquent qu'il y a des

zones fixées. Les lignes 9 & 16 et les colonnes C a G ont disparu de l'affichage par défilement. Les

huit premiéres lignes et les deux premieres colonnes restent parce qu'elles sont fixées sur place.

Vous pouvez déterminer le point de fixation sur une ligne, une colonne, ou sur les deux comme

dans la Figure 28.

Fixer une ligne ou

une colonne

1) Cliquez sur I'en-téte de la ligne en dessous de celle que vous voulez fixer ou de la colonne

a droite de celle que vous voulez fixer.

2) Choisissez Fenétre > Fixer.

Une ligne sombre apparait, indiquant ou le point de fixation a été posé.

I3 4
Figure 28 : Lignes et colonnes fixées

A . H | I |
1 |Populations légales des départements en vig
2 |Mise a jour - décembre 2011
3 |en habitant
4 |Champ : France métropolitaine et départements
5 |Date de référence statistique - 1er janvier 2009
6 |Source : Insee, Recensement de la populat
7
3 y Code Nom du département F'npgl;tiu:un Fopulation
Epartement municipale totale
17 09 Arigge 161 117 166 701
18 10 Aube 303 298 311 676
19 1 Aude 353 980 363 420
20 12 Aveyron 277 048 286 634
21 13 Bouches-du-Rhine 1967 299 1995 094
22 14 Calvados G50 908 B97 054
23 15 Cantal 148 3580 164 354
24 16 Charente 351 563 363 913
035 | 17 [Charente-Maritime 616 607 634 928
26 18 Cher 311 022 319 423
27 19 Corréze 243 352 252 116
28 248 Corse-du-Sud 141 330 143 724
29 2B Haute-Corse 164 344 167 103
30 21 Céte-d'Or 524 144 538 259
31 22 Cétes-d'Armor BaT 519 608 356
32 23 Creuse 123 584 128 435
MArdamana A4 noa AN4A ACC

Affichage de Calc
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Fixer une ligne et une colonne

1) Cliguez dans la cellule qui se trouve juste en dessous de la ligne que vous voulez fixer et
juste a droite de la colonne que vous voulez fixer.

2) Choisissez Fenétre > Fixer.

Deux lignes apparaissent a I'écran, une ligne horizontale au-dessus de la cellule et une
ligne verticale a gauche de la cellule. Désormais, quand vous faites défiler I'écran, tout ce
qui se trouve au-dessus et a gauche de ces lignes restera affiché.

Supprimer la fixation

Pour supprimer la fixation des lignes et des colonnes, choisissez Fenétre > Fixer. La marque

devant Fixer disparaitra.

Scinder I'écran

Une autre fagcon de changer l'affichage est de scinder la fenétre, ou écran. L'écran peut étre scindé
horizontalement, verticalement, ou les deux. Vous pouvez par conséquent avoir jusqu'a quatre

portions de la feuille & I'affichage en méme temps.

Pourquoi vouloir le faire ? Un exemple serait un grand classeur dans lequel une des cellules
contient un nombre qui est utilisé par trois formules dans d'autres cellules. En scindant I'écran,
vous pouvez positionner la cellule contenant le nombre dans une section et chacune des cellules
avec formule dans les autres sections. Vous pouvez alors changer le nombre dans la cellule et voir

comment cela affecte chacune des formules.
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1 |Populations légales des départements en vig
2 |Mise & jour : décembre 2011

en habitant

Champ : France métropolitaine et départements ¢
5 |Date de référence statistique : 1er janvier 2009

6 |Source : Insee, Recensement de la populati
7
a
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Figure 29 : Exemple d'écran scinde
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Scinder I'écran horizontalement
Pour scinder I'écran horizontalement :

1) Déplacez le pointeur de la souris sur la barre de défilement vertical, sur le c6té droit de
I'écran, et placez-le sur le petit bouton en haut avec un triangle noir.

J—M . Barre de scission d'écran

m

Figure 30 : Barre de scission d'écran au-dessus de la barre de défilement vertical

2) Juste au-dessus de ce bouton, vous verrez une ligne noire (Figure 30). Déplacez le
pointeur de la souris sur cette ligne, il deviendra une ligne avec deux fleches (Figure 31).

M T

m

Figure 31 : Barre de scission d'écran au-dessus
de la barre de défilement vertical avec le curseur

3) Gardez appuyé le bouton gauche de la souris. Une ligne grise apparait, qui traverse la
page. Faites glisser la souris vers le bas et la ligne suit.

4) Relachez le bouton de la souris et I'écran se divise en deux, chaque partie ayant sa propre
barre de défilement vertical. Vous pouvez faire défiler les parties supérieure et inférieure
indépendamment.

Notez que dans la Figure 29, la valeur Hypothése d'accroissement est dans la partie supérieure de

la fenétre et les autres calculs sont dans la partie inférieure. Ainsi, vous pouvez changer la valeur
de Hypothése d'accroissement et en voir les effets dans les calculs dans la partie inférieure de la

fenétre.

Vous pouvez également scinder I'écran en utilisant une commande de menu.
Astuce Cliquez dans la cellule juste en dessous et juste a droite de I'endroit ou vous
souhaitez scinder I'écran, et choisissez Fenétre > Scinder.

Scinder I'écran verticalement
Pour scinder I'écran verticalement :

1) Déplacez le pointeur de la souris sur la barre de défilement horizontal, en bas de I'écran, et
placez-le sur le petit bouton sur la droite avec un triangle noir.

- IHEIEHE de scission d' écran

Figure 32 : Barre de scission sur la barre de défilement horizontal

2) Juste a la droite de ce bouton, vous verrez une ligne noire (Figure 32). Déplacez le
pointeur de la souris sur cette ligne, et il prendra I'apparence d'une ligne avec deux fleches.
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3) Gardez appuyé le bouton gauche de la souris. Une ligne grise apparait, qui traverse la
page. Faites glisser la souris vers la gauche et la ligne suit.

4) Relachez le bouton de la souris et I'écran se divise en deux, chaque partie ayant sa propre
barre de défilement horizontal. Vous pouvez faire défiler les parties gauche et droite
indépendamment.

Supprimer les vues scindées
Pour supprimer une vue scindée, faites I'une des choses suivantes :
* Double-cliquez sur chaque ligne de scission.

* Cliquez et faites glisser les lignes de scission vers leur emplacement initial & la fin des
barres de défilement.

* Choisissez Fenétre > Scinder pour supprimer toutes les lignes de scission en une fois.

Utiliser le Navigateur

En plus des champs de référence de cellule (hnommés Colonne et Ligne), le Navigateur apporte
plusieurs autres fagons de se déplacer rapidement dans un classeur et de trouver des éléments
spécifiques.

Pour ouvrir le Navigateur, cliquez sur son icone & dans la barre d'outils Standard, ou appuyez
sur F5, ou choisissez Affichage > Navigateur dans la barre de menus, ou double-cliquez sur le
numéro de séquence de la feuille dans la barre d'état. Vous pouvez ancrer le Navigateur sur l'un
des cotés de la fenétre principale de Calc ou le laisser flotter. (Pour ancrer ou faire flotter le
Navigateur, gardez appuyée la touche Ctrl et double-cliquez dans un espace vide prés des icbnes
du haut de la boite.)

Mavigateur B
B B

Ligne 4 - &= = -

S =] reuile:

Feuillel
Feuilled
Feuille3
g Mems de plage
&éi Plages de base de données
F’ Plages liges
@ Images
= |db Objets OLE
Ohbject1
[£] Commentaires

@ Objets de dessin

F

Colonne | g

4

|San5 noml (active) Izl

Figure 33 : Le Navigateur de Calc
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Le Navigateur montre la liste de tous les objets d'un classeur, regroupés en catégories. Si un
indicateur (signe plus ou fléeche) apparait prés d'une catégorie, au moins un objet de ce type
existe. Pour ouvrir une catégorie et voir la liste des éléments, cliquez sur l'indicateur.

Pour cacher la liste des catégories et montrer seulement les icdnes du haut, cliquez sur l'icdne

Le Tableau 2 résume les fonctions des icbnes en haut du Navigateur.

Contenu . Cliquez a nouveau sur l'icéne pour afficher la liste.

Tableau 2. Fonction des icones du Navigateur
Icéne Action

Plage de données. Sélectionne la plage de données contenant le curseur.

rl:

: Début/Fin. Se déplace vers la cellule au début ou a la fin de la plage de données
.ﬁ. courante, que vous pouvez mettre en surbrillance en utilisant le bouton Plage de
données.

&

Contenu. Affiche ou cache la liste des catégories.
Basculer. Bascule entre I'affichage de toutes les catégories et I'affichage uniquement
de la catégorie sélectionnée.

Scénarios. Double-cliquez sur un nom pour appliquer ce scénario. Voir Chapitre 9
(Analyse des données) pour plus d'informations.

i 1 Kl

Mode glisser. Choisissez Insérer comme hyperlien, Insérer comme lien ou Insérer

'Eﬂ-' i H H T . H 1] H A 1
i comme copie. Voir “Choisir un mode glisser” ci-dessous pour plus de détails.

Se déplacer rapidement dans un document

Le Navigateur apporte plusieurs maniéres pratiques de se déplacer dans un document et d'y
trouver des éléments :

* Pour aller vers une cellule particuliére dans la feuille courante, saisissez sa référence de
cellule dans les champs Colonne et Ligne en haut du Navigateur et appuyez sur la touche
Entrée ; par exemple, dans la Figure 33, la référence de cellule est B4.

* Quand une catégorie contient une liste d'objets, double-cliquez sur un objet pour aller
directement a I'emplacement de cet objet dans le document.

* Pour voir le contenu d'une seule catégorie, sélectionnez cette catégorie et cliquez sur
I'icone Basculer. Cliquez a nouveau sur l'icéne pour afficher toutes les catégories.

e Utilisez les icbnes Début et Fin pour aller a la premiére ou a la derniére cellule de la plage
de données sélectionnée.

Les plages, les scénarios, les images et autres objets sont plus faciles a trouver si
vous leur avez donné des noms significatifs lors de leur création, au lieu de
conserver les Image 1, Image 2, Objet 1, etc., de Calc par défaut, qui peuvent ne pas
correspondre a la position de I'objet dans le document.

Astuce

Choisir un mode glisser

& -

L'icbne détermine les options glisser-déposer pour insérer des éléments dans un document
en utilisant le Navigateur.
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Insérer comme hyperlien
Crée un hyperlien quand vous glissez et déposez un élément dans le document courant.

Insérer comme lien
Insére I'élément sélectionné en tant que lien a I'endroit ol vous glissez et déposez un objet
dans le document courant.

Insérer comme copie

Insére une copie de I'élément sélectionné a I'endroit ou vous glissez et déposez dans le
document courant. Vous ne pouvez pas insérer des copies d'images, d'objets OLE et d'index.

Utiliser les propriétés du document

Pour ouvrir la boite de dialogue Propriétés d'un document, choisissez Fichier > Propriétés.

La boite de dialogue Propriétés comporte six onglets. Les informations des onglets Général et
Statistiques sont générées par le programme. Les autres informations (le nom de la personne des
lignes Créé le et Modifié le sur I'onglet Général) proviennent de la rubrique Données d'identité
dans le menu Outils > Options.

L'onglet Internet n'est significatif que pour les documents HTML. Les options de partage de fichier
de l'onglet Sécurité sont abordées ailleurs dans ce livre.

Utilisez les onglets Description et Propriétés personnalisées pour gérer :

* Les métadonnées pour aider a classer, trier, stocker et retrouver les documents. Certaines
de ces métadonnées sont exportées vers leur équivalent le plus proche en HTML et PDF ;
certains champs n'ont pas d'équivalent et ne sont pas exportés.

* Les informations qui évoluent. Vous pouvez entrer des données pour étre utilisées dans les
champs de votre document ; par exemple le titre du document, l'information du contact
pour un projet collaboratif ou le nom d'un produit qui peut changer au cours d'un projet. Le
champ Titre est la seule de ces propriétés qui pourra étre utilisé en en-téte ou pied de

page.

Cette boite de dialogue peut étre utilisée comme modéle, ou le nom des champs peut servir de
pense-bétes aux utilisateurs de l'information qu'ils ont besoin de remplir.

Vous pouvez retourner a cette boite de dialogue a tout moment et modifier les informations que
Vous avez saisies. Sivous le faites, toutes les références a cette information changeront ou
gu'elles apparaissent dans le document. Par exemple, dans I'onglet Description (Figure 34), vous
pourriez avoir besoin de changer le contenu du champ Titre du titre de travail au titre définitif.

e

Propriétés de Sans noml @

Général | Description | Propriétés personnalisées | Internet | Sécurité | Statistiques

Titre Graphiques pour réunions

Sujet Exemples de graphiques Calc

Mots-clés Calc, graphique

Commentaires -

Figure 34 : Onglet Description de la boite de dialogue Propriétés d'un document
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Utilisez I'onglet Propriétés personnalisées (Figure 35) pour gérer des informations qui ne rentrent
pas dans les champs des autres onglets de la boite de dialogue.

Propriétés de Sans noml (%]

Général | Description | Propriétés personnalisées |Internet | Sécurité | Statistiques

Propriétés

Mem Type |‘u‘a|eur | |

| v | [Texte - |ER|
Vérifié par -
Client

Acheveé 3 la date
Service
Destinations
Disposition
Division -

m

m

| Ajouter |

OK || Annuler || Aide || Rétablir |

Figure 35 : Onglet Propriétés personnalisées

Quand l'onglet Propriétés personnalisées est ouvert pour la premiére fois dans un nouveau
document, il peut étre vide. Cependant, si un nouveau document est basé sur un modéle, cet
onglet peut contenir des champs.

Cliquez sur Ajouter pour insérer une nouvelle ligne de champs dans lesquels vous pourrez saisir
VoS propriétés personnalisées.

La colonne Nom comprend une liste déroulante de choix caractéristiques ; faites défiler
pour voir toutes les possibilités. Si aucune de ces possibilités ne correspond a vos besoins,
VOUS pouvez saisir un nouveau nom dans le champ.

Dans la colonne Type, vous pouvez choisir entre texte, date heure, date, durée, numéro ou
oui ou non pour chaque champ. Vous ne pouvez pas créer de nouveaux types.

Dans la colonne Valeur, saisissez ou sélectionnez ce que vous voulez faire apparaitre dans
le document quand ce champ est utilisé. Les choix peuvent étre limités aux données
spécifiques des types choisis dans la colonne Type ; par exemple, si le type sélectionné est
Date, la valeur pour cette propriété est limitée aux dates.

Pour supprimer une propriété personnalisée, cliquez sur le bouton a la fin de la ligne.

Astuce

Pour changer les formats d'une valeur de Date, allez a Outils > Options >
Parameétres linguistiques > Langues et modifiez le paramétre Environnement
linguistique. Attention ! Ce changement affecte tous les documents ouverts, et pas
seulement le document courant.
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